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QUICK START

DevComFF.Win uses Device Descriptions (DDs) to access data stored in the memory of the smart field device.
These DDs are developed by the manufacturer for their products and, in turn, distributed by the FieldComm Group
(FCG) worldwide. The latest DDs are included as part of the DevComFF installation. Visit the FCG website
(www.fieldcommgroup.org) or the ProComSol website (www.procomsol.com) for update information.

The following steps will allow you to install and quickly begin using DevComFF.Win:

Step 1: Install the DevComFF.Win application

Insert the DevComFF.Win installation USB drive into a USB port on your computer. Launch the Windows File
Manager application. Double click on the DevComFF_Setup.exe file. This will begin the installation program.

Step 2: Activate DevComFF.Win
Launch DevComFF.Win by selecting the DevComFF icon on your desktop. You can also start the application by

going to your computer's Start Menu and selecting Start > Programs - ProComSol > DevComFF >
DevComFF to launch the program.

You will now be asked to Activate DevComFF. If you have Activation Codes (located in the USB drive shipment
or distribution email), select the Activation method of your choice (Manual or Online). Select the Evaluate option
if you do not have Activation Codes. You can use DevComFF.Win for 10 days before you need to activate it.

If you are Activating DevComFF.Win by the online method, select online activation. You will be asked to enter the
Activation Codes on the next screen. Once entered, DevComFF.Win will connect to the Internet to verify the
Activation Codes. If you do not have an internet connection, you can activate it by email or phone using the
Manual Activation method. Activation details are fully explained later in this manual.

Activation only needs to occur once.

Step 3: Connect the mobiLink communication interface

Connecting to a Foundation Fieldbus device requires special interface hardware to be attached to your computer.
DevComFF only works with the MOBI-FF and MOBI-CMPLT modems available from ProComSol, Ltd and other
sources. The modem should be connected and configured.

Step 4: Connect to the Foundation Fieldbus (FF) network
Connect the mobiLink to the FF network at the power hub or other dedicated FF access point for communicators.

Step 5: Live List

Click the New Device icon to start populating the Live List. The Live List shows all the FF devices connected to
the segment powered by the Power Hub. Click on the device you wish to configure or view.

Step 6: Browse the Device

Operating DevComFF.Win is similar to working with Windows® Explorer. DevComFF.Win communicates to the
field device, establishes a connection and learns its identity. Once DevComFF.Win knows its identity,
DevComFF.Win locates the device's DD and loads it. From this point forward operation of DevComFF.Win is
determined by the DD provided by the product's manufacturer. If a DD for the device is not present, an error
message is given showing the details of the file it is looking for.
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The device Blocks can be accessed by clicking the Blocks sub-menu on the top menu bar. Once a Block is
selected, DevComFF will open the Browser window. The organization of the data in this explorer-style window is
dictated by the device DD. The left hand tree-pane of this window shows the logical groups of field device data.
These are called "Menus". The right hand data-pane shows the data, any sub-groups and any Methods found on a
given menu.

You can browse through the field device data by expanding (click "+" symbol) or collapsing (click the "-" symbol)
the menus in the tree-pane. You can also double-click the folder symbol when seen on the data-pane.

Step 7: Modify the Device's Configuration
The Browser window allows access to all of the data exactly as described by the product's manufacturer’s DD.
When you find elements of the field device's configuration you want to change, simply double-click and edit the

data. Once you have changed the configuration to suit your needs, press the Send icon B to commit the data and
transfer it to the field device.

Step 8: Performing Maintenance and Testing the Field Device

Many devices perform Methods or Standard Operating Procedures (SOPs) that may need to be performed to ensure
the device is in peak condition. These Methods may include trimming the transducer values or performing some
diagnostic test on the field device. Methods appear in the data-pane just like data does. Double-click on the
Method and it will start running in a separate window. The Method will guide you through the process ensuring the
procedure is completely and consistently performed. When the Method is complete the window will disappear.

Step 9: Exit
When you are through working on the field device simply exit DevComFF.Win. Once the program exits, you can
then disconnect the mobiLink from the segment.
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1 INTRODUCTION

The Smart Device Communicator (DevComFF.Win) allows access to and management of a Foundation Fieldbus
(FF) compatible field device's configuration and calibration. This manual provides the information about the
Hardware setup, Communication with Smart devices, and functions of DevComFF.Win.

DevComFF.Win is unique in that it uses the DD of the connected device to determine what information to display,
what variables are available for edit, and what procedures to follow for calibration, setup, and maintenance.

1.1 Acronyms and Definitions

Acronym Definition

FF Foundation Fieldbus

COTS Commercial-off-the-Shelf

DD Device Description File. This contains the device
information.

DDL Device Description Language

FCG FieldComm Group

DevComFF.Win Smart Device Communicator Software

1.2 Conventions Used in This Manual
Following formatting conventions are used in this guide:

Convention Description

Words in bold type Field names including buttons in the display,
or important phrases.

- Arrow Windows pull down menus and their options
are separated by—>.

For example, click Device - New Device to
connect to a new device.

Courier font Information that you type, parts of the code

quoted for explanations or as examples.

UPPERCASE

UPPERCASE within
angle brackets

Acronyms

Command keys
For example, press <ENTER>.
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1.3 Document Organization
DevComFF.Win user manual is organized into the following sections:

Section 1 Describes the scope and objective of DevComFF.Win user
manual along with the organization of the remaining part of
the manual.

Section 2 Provides an overview of the DevComFF.Win application
and its architecture.

Section 3 Provides the information pertaining to hardware and
software requirements for the DevComFF.Win application.

Section 4 Provides the steps to install, activate, and uninstall the
DevComFF.Win application.

Section 5 Provides the steps to start the DevComFF.Win application
and connecting to field devices.

Section 6 This section explains different aspects of the
DevComFF.Win application and its functionalities.

1.4 Getting Help

If you need help or encounter problems when using DevComFF.Win or this guide, please contact ProComSol, Ltd.
See Appendix B for contact information. Please provide the following information.

Create a text description of the problem. If possible, provide the text in event sequence, which will enable
the duplication of the problem. Provide information about the system. This information must include:

e DevComFF.Win version and License ID
e Computer Windows version
e Device information: make, model, and device revision

e Point of contact: complete mailing address, telephone number, and e-mail address,
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2  OVERVIEW OF DEVCOMFF.WIN

Field devices such as flow, pressure, level, temperature transmitters, and valve positioners provide the physical
connection to the process. These devices allow the control system to monitor and manipulate process conditions.
Foundation Fieldbus (FF) devices maintain a real-time database of process, configuration, identification, and
diagnostic information. This information can be accessed using the FF Communications Protocol.

FF devices are capable of providing functions and features far beyond the basic task of providing a process input or
accepting a control output to manipulate process conditions. FF device manufactures create a DD (Device
Description) describing all of these functions and features specific to that device. The DD also provides information
essential to the successful configuration and calibration of the device.

DevComFF.Win uses these DD’s to access the data stored in a device, providing full configuration and setup
support for all registered FF DD’s.

DevComFF.Win accesses and presents field device data based solely on its DD. DevComFF.Win is intended to
monitor and configure a single device at a time and:

e Provides user interface to configure the FF field device,
e Provides a means to configure and view all the parameters related to FF field device, and
e Provides an option to view the detailed status and diagnostic capability of the FF device.

DevComFF.Win allows viewing and modifying of field device parameters based on the DD. Using the device’s
DD, DevComFF.Win performs various tests to verify the proper operation of the FF device. DevComFF.Win runs
as a standalone software package and must have a mobiLink attached to the system to interrogate the FF devices

System Requirements

The following minimum system requirements are recommended for operation of DevComFF.Win.

PC Processor Speed: Pentium, 600 MHz
Memory: 256 MB

Hard Disk Space: 500 MB

Monitor: 256-color VGA

FF Modem mobiLink modem. ProComSol provides
MOBI-FF and MOBI-CMPLT which will
work with DevComFF.Win. MOBI-PWR-
FF and MOBI-PWR-CMPLT will also

work.

Communication Port USB or Bluetooth

Operating System Windows 7 Note that Windows 10 is
preferred.
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3 DEVCOMFEWIN INSTALLATION

3.1 Prerequisites
You need to be familiar with the basic functions of the following when installing the DevComFF.Win tool:

e Microsoft Windows
e FF communication interface
e FF field device
3.2 Installing the DevComFF.Win Application

To install the DevComFF.Win application in a standalone system, perform the following steps:

Step  Action

1 Insert the DevComFF.Win USB drive into a USB port on your

PC.

2 Click Start and choose Run. From the Run window, click
Browse.
In the Look In box, browse to the USB drive.

4 Double-click the drive to access the USB content.

5 Look for the DevComFFSetup.exe file and double-click the
same. This process will take you through a sequence of
installation wizard steps.

6 Follow the instructions on the upcoming screens to complete the
Installation.

3.3 Activating DevComFF.Win

DevComFF.Win must be activated before use. If the program is not activated, it will not run after 10 days. The
following procedure will activate the software.
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Step  Action

1 Start the DevComFF.Win Application. The following
Activation window is displayed:
= DevComFF >
DevComFF

Thank you for trying DevComFF. Your trial has expired.

=» Purchase DevComFF Online

Open my browser to the onling ordering page

5 Activate DevComFF

| have already purchased and would like to activate the
product

Go To Website

& Exit

If you want to evaluate DevComFF.Win before purchasing,
select the “Evaluate DevComFF.Win” option. You will have 10
days of unlimited program use before you will need to purchase
a license. Select “Purchase DevComFF.Win Online” to go to
the ProComSol, Ltd website to purchase a license.

2 If “Activate DevComFF.Win” is selected, the following window
appears:
3 If the “Activate DevComFF.Win Online” option is selected, the

following window appears.
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~ License ID and Password *
DevComFF

Please enter your License ID and Password found on the CD
Label or received through your email.

Please enter your License 1Dt

Where is my License ID?

Please enter your Password:

Click here for support

{3 Back # et

Enter the information from the Activation post card or email.
Select “Continue” to process the information.

If the codes were successfully entered, the program will continue
as normal. You will not need to perform the activation process
again.

4 If the “Activate Manually” option is selected ou will then need
to contact ProComSol, Ltd to obtain the Activation Codes. You
must supply the User Codes to ProComSol, Ltd support
personnel. You can register manually in any of the following
ways:

1. Call ProComSol, Ltd at 216.221.1550. Have the program
License ID and User Codes ready.

2. Or, send an email to support@procomsol.com containing your
company name, License ID, and User Codes.

The above information will be processed at ProComSol, Ltd and
an appropriate response will contain the required Activation
Code information that the user will need to enter.

If successful, the program continues as normal. You will not
need to perform the activation process again.

5 We have tried to make the Activation process as easy as
possible. Contact ProComSol, Ltd if you have any difficulties.
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3.4 Connecting to the FF Network

The DevComFF.Win application communicates with FF Field Devices through a FF compatible communication
interface, the mobiLink. Using this communication interface you will transmit real-time FF data between
DevComFF.Win and the selected FF field device.

Insert the USB connector on the mobiLink into your computer’s USB port. Using the clips on the wires from the
mobiLink, connect to the FF Power Hub or other dedicated FF communicator connection point.

Figure 1 Typical DevComFF.Win Hardware Setup

3.5 Uninstalling the DevComFF.Win Application
To uninstall the DevComFF.Win application, perform the following steps:

Step  Action

1 Click Start > Programs - ProComSol - DevComFF >
Uninstall DevComFF

Or, Click Start - Settings > Apps

Click the DevComFF.Win program that you want to uninstall.
Click Uninstall.

[V, T I SN B OS T ) \S)

Click OK to confirm the removal of the selected application.
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4 USING DEVCOMFF.WIN

4.1 Starting DevComFF.Win

Connect the mobiLink to the USB port on your PC and connect the FF leads to the FF power hub or dedicated FF
communicator connection point. With the physical connection established, launch DevComFF.Win by clicking the

DevComFF icon on your desktop. You can also start the application by going to your computer's Start Menu and
selecting Start > ProComSol > DevComFF.

4.1.1 Live List

When first launching DevComFF.Win, the software determines what devices are connected to the FF Segment. It
polls address 0-247 and shows the results on the Live List. Below is an example:

Live List

N J Address ] Tag I
0y 34 R-0301-TEMP2
01 26 FT105-1
Live List Updated
maobiLink Settings

You may need to make changes to the mobiLink settings in order to connect to your FF network. Click mobiLink
Settings to bring up the mobiLink Settings Dialog Box.
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lines | ict

mabilink Settings

Slot Time: I 3 1 to 4005

Max Response Delay: 1to 11

Min InterPDL Delay: 0 to 255

First Unpolled Addr: 20 to 247

Last Unpolled Addr: | 247 21 to 247

Polling Range: | 17 to 127, 248 to 255

Restore Defaults

4.1.2 FF Device Connect

Once the Live List is displayed, simply click on the device you want to configure. You will then be prompted to
change the Tag or Address or to connect to the device. Below is an example:

lyeo |ict

Device Details

Address: I 26

{Range 20 to 247)

Taq: | FT108-1

(Max 32 characters)

Device ID: I 394543000310016034
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Click the Connect button to connect to the FF device. The Browser window will now open with the Block List
highlighted. Here is an example:

“Jr Browser

Device Options  Wiew

‘@28 (8 m

Tending DDlibrary Cloud License Window Help

Analog Input
PID Control
Resource Block 2

| @ FF Activity | & TrendActivity | | | A

Select the desired block to view. You then navigate through the menus as needed. Below is an example:
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“J Browser - [EJA Transducer Block]

(B8 & mB

"7 Device Options View Blocks Trending DDlLibrary Cloud License Window Help

-8 x

=-{] Parameters
(23 Transducer Directory
{23 Collection Directory
(23 Test13
£ Test14
{3 Test17
=3 Menus
{22 Block Info
(22 Block Mode
=2 Dynamic Variables
(2 Primary Value
(23 Secondary Value
£ Tertiary Value
= Configuration/Calibration
{1 Block Mode
E=-{2] Primary Value Parameters
(23 Primary Value Range
.1 Calibration
(22 Display Setup
=1{1 Device Information
£ Sensor Information
(23 Sensor Range
(] Diagnostics/Alerts
(22 Block Alarm
{2 Alarm Summary
(22 Update Event
=-{Z3 Query Device
= TEB Profile Parameters
©.{22 Block Mode
{1 Update Event
{22 Block Alarm
(3 Primary Value
4.2 Primary Value Range
.23 Sensor Range
=.{1 Secendary Value
(2] TB Original Parameters
(3 Tertiary Value
L. Alarm Summary

Item

Value | Units

"] Parameters

6] Menus
&, Sensor Calibration Wizard

Tag: FT106 - Device: EJA (Software Download) /LC1 - Device ID: 5945430008/0016034 - DD: \594343\0008\0105.ffo

O FF Activity €) Trend Activity

4.2 Getting Familiarized with DevComFF.Win Explorer

4.2.1 Using the Menus

DevComFF.Win Explorer provides visual representation and structure of the application window.

Menu

Explanation

Document Device
Download / View
CalCheck

Exit

Live List Ctrl+L

sub-menu options:

The Device Menu offers the following

Live List - Brings up the Live List dialog
box that shows the devices that are
connected to the segment that the
mobiLink is connected to.

Document Device — Brings up the
Document Device dialog box used to save
the device configuration to disk.
Download / View — Brings up the
Download dialog box which provides
Configuration File features.

CalCheck - Brings up the CalCheck
dialog box for performing a check of the
device performance.

Exit - Exit DevComFF.Win.

MAN-1053 06/09/2021
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~  Status Bar

Device Status

Event Log

Basic The Options Menu brings up the Options
menu for setting DevComFF.Win
behaviors.

B Tocibar ) The View Menu offers the following sub-

menu options:
Toolbar - Hide or show the Tool Bar.
Status Bar - Hide or show the Status Bar.

Device Status — View device status for
each Block.

Event Log — View log of events

EJA Transducer Block
Analog Input
PID Control

Resource Block 2

The Blocks Menu is determined by the
device connected to. The image shown is
an example. Click on the desired Block to
configure or view.

Define Trend

View Current Trend
View Past Trends
Stop Current Trend

The Trending menu offers the following
sub-menu options:

Define Trend — Brings up the Define
Trend dialog box where a trend is started.

View Current Trend — Brings up a real-
time graph of values currently being
trended.

View Past Trends — Brings up the View
Trend dialog which contains past trend
files. Selected trend files can then be
graphed.

Stop Current Trend — Stops the current
log in process.

Add DD
Available DDs
Check For Updates

The DD Library menu offers the
following sub-menu options:

Add DD — Brings up the dialog that adds
a DD to the library. Also used to give
labels to non-standard library DDs.
Available DDs — Brings up a browser of
all the DDs installed in the library.

Check For Updates — Shows current DD
Library version and checks for DD library
update

MAN-1053 06/09/2021
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Options
User

Group

The Cloud menu offers the following sub-
menu options:

Options - Brings up the dialog box that
sets the Cloud Options

User - Brings up the dialog box that sets
the User Options including Log in

Group - Brings up the dialog box that sets
the Group behaviors including joining a
group.

Details
Check-In (Return)

The License window offers the following
sub-menu options:

Details — Shows License ID and Password
information.

Check-In (return) — Returns license to
our server and closes program

Cascade

Tile

v 1 Table View

The Window menu offers the following
sub-menu options:

Cascade — Organizes open windows in a
cascade arrangement.

Tile — Organizes open windows as tiles

1 Table View — List of the open windows.
Click to select the window to view

DevComFF Help
Com Troubleshooter
Device Help

About DevComFF

The Help menu offers the following sub-
menu options:

DevComFF Help — Brings up Help
information for the DevComFF.Win
application.

Com Troubleshooter — Brings up the
DevComFF.Win Com Troubleshooter.
(not available yet)

Device Help — Brings up help information
for the connected device (if available).
About DevComFF — Shows copyright
information, support information, and
application Version Number.

4.2.2 Using the Toolbar

When you start the application, by default, the toolbar buttons appears on the main window. If it fails to display,
click View = Toolbar option from the menu bar to bring up the toolbar.
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Following are the buttons available in the DevComFF.Win application toolbar to perform the necessary tasks:

Button Description Corresponding Menu Option

Load the Live List Device = Live List

Send parameter changes to the
device (Commit)

(Cancel)

View Block device status View = Device Status

]
k-
? Cancel parameter changes
&

View Event log View = Event log

4.2.3 Icons
DevComFF.Win application uses different icons to represent different elements of the application. Following table
lists the icons and their meanings:

Icon Meaning

Indicates a menu or submenu in the navigation tree

Indicates a currently selected menu or submenu in the
navigation tree

Online menu icon. The actual DD menu comes under this.

Indicates a “Variable” item

Indicates a “Method” (Standard Operating Procedure) item

Indicates an “Edit Display” item

Indicates an “Image” item

B E &S & 0L

Indicates a “Graph” item
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S FUNCTIONS AND BASIC OPERATIONS

5.1 Overview

DevComFF.Win allows the user to monitor and configure a single device at a time in the field. Each device is
associated with the DD when the device information is present. A DD may contain any of the following
parameters/elements:

Variable

A variable is defined as the data contained in the device (e.g. Device Firmware Version). There are two types of
variables:

Editable Variable — It allows the operator to modify the value and download it to the device.

Non-Editable Variable — It is a read-only data from the device.

Edit Display

This option is used to view a group of parameters. You can also modify a single parameter from this group, based
on which other parameters of the device get altered.

For example, if the Engineering Unit of the device is modified, the corresponding Low Limits and High Limits
change as per the Engineering Unit set.

Method / Standard Operating Procedure (SOP)

This option helps to perform various tests on the device for instance, Self Test. A Method or SOP is a series of
steps that are executed in a sequence results in the completion of some device related tasks. When a method gets
invoked, it gives various warning messages and options to the user, by which the user can thoroughly test the
device. If a test is aborted by operator command at any stage of the sequence, the method invokes additional steps
to bring the device back to its original state before the test.

5.2 Viewing Device Parameters
To view the configuration of the device that is connected to DevComFF.Win, perform the following steps:

Step  Action

1 Ensure that the application is running and communications have
been established:
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Step

Action

& Browser - (B4 lock] - 0 x

Blocks Trending DD Library Cloud License Window _Help

Value [ Units

The left pane of the window shows the menu structure and the right
pane of the window displays corresponding parameters of the menu
selected.

The menus are displayed depending on the type of device that is
being connected. These menus are displayed based on the DD file
of the particular device.

Note that the menus in this document are typical and will differ
based on what FF device you are connected to. The menus are
determined by the Device DD.

Expand the menu by clicking the “+” sign and double-click to view
the device parameters. Below is an example of an expanded menu:

- o0 x

nnnnnnnnnnnnnnnnnnnnnnnnn

None

nnnnnnn

.................

CE6S8SULEESSPULSLSSEE

[Tags FT106 - Device: G- © FF Activty © Trend Activty

Select the menu and view the associated parameters to view the
device information.
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5.3 Configuring Device Parameters
5.3.1 Overview

DevComFF.Win allows you to view and configure the field device parameters based on the device description.
However, the device vendor defines most of the parameters at the factory. These parameters become read only
for the users and the user cannot modify the values. The related variables are grouped under various menus of
different levels as defined in the DD file. Expand or collapse the tree view using the “+” or “-“sign to access
the device configuration parameters.

Following table describes the details about the device configuration:

Step  Action

1 Ensure that the application is running and communications have
been established:

| v rom

The left pane of the window shows the menu structure and the right
pane of the window displays corresponding parameters of the menu
selected.

2 Expand the menu by clicking the “+” sign and double-click to view
the device parameters.

3 There are three types of variables: dynamic, read/write and read
only. The parameters that are grayed out indicate that these are
dynamic variables (variables that get updated online by the device)
or read only variables.

Following points describe how the device parameters represents
their status when connected to DevComFF.Win:

Bold Font: Modifiable Values
Normal Font: Menu Item

4 Select the parameter and configure the values, as required.

5 The subsequent topics explain how to configure device parameters.
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5.3.2 Variable
To edit the parameter variables of the connected device, perform the following steps:

Step  Action

1 Ensure that the application is running and communications have
been established:

lock] - o0 x
flew Blocks Tiending DD Library Cloud License Window Help

Value [ Units

[Tagt FT106 - Device: 1

Expand the menu by clicking the “+” sign and double-click to
view the device parameters.

2 Select the menu where the editable parameter is present as shown

ons_View Blocks Trending DD Library Cloud _License Window _Help

SEOOEECEEUILBUEEES|7

&80

[T

[Tags FT106 - Device: G- © FF Activty © Trend Activty

3 Double-click the variable to edit it. The following dialog box
appears on the screen:
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Step  Action

|
3 Device Options View Blocks _Trending
0?35 (0 )E]

DD Librar

Cloud

Window _Help

5 03 DA Transducer Block
563 Parameters

Q2 Transducer Directory

2 Collection Directory

Q2 BlockInfo
Q2 Block Mode
2 Dynamic Varisbles
23 Primary Value
2 Secondary Velue
23 Tertory Velue
€2 Configuration/Calibration

5 03 Primary Value Parameters
22 Primary Value Range
Q Calibration
€2 Display Setup.
53 Device Information
53 Sensor Information
2 Sencor Range
2 Disgnostics/Alets
€2 Block Alam
22 Alarm Summar
32 Updste Event
2 Query Device
53 TB Profle Parameters
2 Block Mode
2 UpdteEvent,
22 Block Alarm

Q2 Secondary Value
&3 T8 Orginal
Tertiary

Parameters
Value
Q2 Alerm Summary

Static Revision

@ mu
o
p rao
©
ow

© e
® oos

Block Alarm . Subcode
Block Alarm . Value

Units Index

Sensor Cal Who

Ve U
s

0x20,0x20,0%20,0x20,0%...

01/01/1972 00:00:00.00...
o

o
Acknowledged
Clear-Reported
01/01/1972 00:00:00.00...
Other

o

Standard Pressure

ifferential pressure
Good_NonCascadexNons.

“0.012015

71117

psi

20

o
e E— 071117

Silicon resonant
71,11

71117

psi

1

factory trim standard cal...

:00.000

eg = —_— - _ _[© Fe Ay © Trend Activity v,,
4 Make the changes to the parameter value, as required.
5 Click Set to accept the changed value. The change gets reflected
as shown:
b4 4
= 2 DA Transducer Bock T Votue [ Unis ~
=
3 Test 14
03 Test17
22 Secondary Value: 2
Q3 ety Value Acknowledoed
& Mode: 01/01/1972 00:00:00.00.
(3 Device Information il S f—_—
P Wil
2 Block Alarm EU at 100% 71117
i Ly catpomen pecm! »
2Q Erwiepma: touil s
{2 Primary Value Range. Sensor Range . EU at 0% 71117
{2 Sensor Range Sensor Range . Units Index psi
A= = ,
b oo Sensor Cal Hethod foctory trm standard cal...
C2 Aarm Summary Senaor cal Date 01/01/1984 00:00:00.000

6 Click on the Send icon i to commit the

changes to the device.

7 When the value is no longer yellow, the variable has been changed
in the device.
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Step  Action

i Browser - (Explorer]
ew Blocks Trending DD Library Cloud License Window Help

(7Y

DebD

o
aR
coabooopoppas

&

factory trim standard cal...

01/01/1984 00:00:00.000

Tag: FTI06 ] © FFActivty © Trend Actvity

The Send and Cancel Icon will now be grey as well. This indicates
that there are no new changes to be sent to the device.

5.3.3 Executing Methods or Standard Operating Procedures

Methods are defined in the DD file for the device that DevComFF.Win is connected to. You can select the
Method and execute it for calibrating the device, trouble shooting, etc. Method execution leads you through a
number of steps, like in a wizard.

A Few examples of methods include:

- Calibration of the device
- Run the advanced diagnostic test procedure
- Execute tests to gather information on device operation.
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To execute a Method, perform the following steps:

Step  Action

1 Ensure that the application is running and communications have been
established:

lock] - o x
few Blocks Tending DDLibrary Cloud Licenze Window Help

Value [ Units

[Tag: FT106 - Device: £ 1- Device D © FF Actity © Trend Activity

Expand the menu by clicking the “+” sign and double-click to view
the device parameters.

2 Select the menu where the method is present and double-click to
execute it.
3 Below is an example of a Method dialog box:

Sensor Calibration Wizard

Which calibration point?

Low Point(Cal PointLo] |

High Point[Cal Point Hi]
Exit

Presz 0K button to continue method execution or Abort button to abort method execution.

Mext ‘ Abart ‘ Help |

4 Click Next to move to the next dialog in the Method sequence.

5 Or, click Abort to cancel the Method execution.

6 Click Help to get specific help for that step of the Method. This
Help information is provided by the device DD.
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5.4 Calibrating FF Field Devices

Calibration of field devices are achieved by executing the Methods or Standard Operating Procedures that are
specific to device. Methods are defined based on the test parameters specific to the device, providing information
for the calibration of that device.

See the previous section for Method execution.

5.5 Viewing the Device Status
DevComFF.Win provides the user with the ability to monitor the device specific status of the device Blocks.

When there is error communicating with the device, it is recognized and indicated to the user. The user can view
more details of such errors, using the View - Device Status from the main window.

To view the device Block status, perform the following steps:

Step  Action

1 Ensure that the application is running and communications have
been established:

Expand the menu by clicking the “+” sign and double-click to view
the device parameters.

3 Select View = Device Status from the main window or choose the
status icon & from the toolbar. Following window is displayed:
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Step  Action

locks_Trending DD Library Cloud License Window Help

Value [ Units

0%20,0x20,0x20,0x20,0%...
1

mmmmmmm

(TN

Sen:
Sen:
Sen

sor Cal Who
Tagi FTI L1 - Device ID: © FF Actty © Trend Activity NOM

5 Click OK to close the Status window.

5.6 Viewing the Event Log

DevComFF.Win allows the user to view the error conditions of the device and the communication network.

To view the Event-Status Log, perform the following steps:

Step  Action

1 Ensure that the application is running and communications have been
established:

0 Browses - [UA Transducer Block] - o x

jons _View Blocks Tending DD Library Cloud License Window Help

Value | Unite

[Tog:FT T 0 FF Activity © Trend Actvty

Expand the menu by clicking the “+” sign and double-click to view
the device parameters.

2 Select View > Event Log from the main window or choose the
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Step  Action

Event log icon £ from the toolbar. An additional Event Log window
is displayed:

& Browser - [Window View]

View Blocks Trending DD Library Cloud License Window Help
7| & =]

37372021 155,
37372001 1550: < Fail
3/3/2021 15:52:37 Error. DD File header information does not match file name.
3/ 372001 1555241

‘CAProComSoNFRL

[Tog: FTI05 - Device: £ LC1 - Device ID: 0D:

Q _FF Activity Q _Trend Activity NUM

To close, go to View = Event menu option or click on the 2 icon
to go back to the original window.

5.7 Saving Device Configuration to Disk (Document Device)

FF Device configurations can be saved to disk as a PDF and comma delimited text file to document the device.

Data from the text file can be imported into configuration management software packages. A PDF version of the
configuration is also created.

To save device configurations to disk, perform the following steps:

Step  Action

1 Ensure that the application is running and communications have been
established:

 Block]

Blocks Tiending DD Library Cloud License Window Help

tem

Vo
{3 Par

[Tog:FT T 0

© FF Adtivity © Trend Actvity
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Step  Action

2 Select Device 2 Document Device from the main window. The
Document Device Dialog Box is displayed:

em Value [ Units
]

0x20,0x20,0%20,0%20,0x...
1

55555

[ ot T8 20200214618

Notes:

Notes” must be fes than 250 characters.

SaveDovesCon |_POF Sep

factory trim standard cal...

01/01/1984 00:00:00.000

LC1 - Device I oD © FFAciity © Trend Activity

3 The default directory is based on Windows User Accounts. The
default file name is Tag Date Time. The directory and filename can
be changed by the user. Use the “Browse” button to change
directories and/or filenames also.

4 Enter a Note in the Notes: field if desired. Maximum of 250
characters.
5 Press the “Save Device Config” button to save device configuration.

5.8 Download Configuration to Device

Saved configuration files can be downloaded back to devices. This is useful for “Cloning” a device, either for
replacement or plant setup.

To save device configurations to disk, perform the following steps:

Step  Action

1 Ensure that the application is running and communications have been
established:
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Step

Action

- [BA Tansducer Block] - o x

jons _View Blocks Tending DD Library Cloud License Window Help

Value | Unite

[Tog:FT T 0 FF Activity © Trend Actvty

Select Device 2 Download from the main window. The Download
Dialog Box is displayed:

Downlosd Fie X

Avalable Configurations (Double Cick o Selec]

N7 Thewes Toae Tocston
o o it isie Loca
@ o ElASoweDomsg A1 20210303 Loen
Do Tog T8 Broms
Corbgusion e Tag [ Evtr e Tagi desed (2 Chrcter i)
Devie: |
FloName: |
Dot |
Notes

i ven Unountosd
e

01/01/1984 00:00:00.000

(Tag: FT106 - Device: £ LC1 - Device I © FF Activity © Trend Activity NUM

The available configurations are displayed. You can sort on each
column by clicking it.

To get details about a configuration, select the desired configuration
and double click it. The details will be displayed below:
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Step  Action

Tag: FT106 - Device: A LC1 - Device ID: EEE‘"‘:H‘ Iwm - © FF Activi ity © Trend Activi ity NUM
4 You can change the desired Tag by editing the Configuration File
Tag box.
5 Press the “Write” button to write device configuration to the

connected device. The device must be the same type as the
configuration file. If they are different, the write operation will be
aborted.

6 You can view the PDF file for the configuration file by double
clicking on the desired configuration and pressing “View”.

7 You can delete configurations by double clicking on the desired
configuration and pressing “Delete”.

5.9 Customizing PDF File Output

FF Device configurations can also be saved to disk as PDF Files to document the device. The header, footer, and
technician name can be entered to customize the PDF file to make it into a configuration report.

To customize the PDF output, perform the following steps:

Step  Action

1 Press the “PDF Setup” button on Document Device Dialog Box:
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Step  Action

Value | Units ~

s
0%20,0%20,0%20,0x20,0%...
1

1
oos

Auto
005,Auto

FieHae
BI0CK G\ \imbor 7 Cok P08 2AETCATE_ THAEES B | !

Notes:

“Noles" st be less then 250 charactes

DEer

SaveDevice oy | _POF Setup [ Cose

@
B £
cbosboooooess

factory trim standard cal...

01/01/1984 00:00:00.000

Tag: FT106 - i © FFActivity © Trend Activity

2 The PDF Setup Dialog box is displayed:

[ PDF Setup [ |

Header: |Llser kM anual Device Config

[ Use Tag az Header

Footer: |F|:n:|ter for the Device Conlig

Tech: ]Gu_l,l Instrumenﬂ

(] | Cancel

L

3 Enter data as needed and press OK. The data is saved for future
configuration saves.

4 Below is a sample PDF file.
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Step  Action

User Header

Device Configuration File: Rev 1.0

File: C:\Users\jdobos\FF Configs\FT106_20210302_144603

Tag: FT106

Device ID: 5945430008J0016034

DD: \594543\0008'0105.ffo

Date (yyyy-mm-dd): 2021-03-02

Time (hr:mn:sc): 02:47:54 PM
Tech: Tech name
Notes:

Variable

Block: EJA Transducer Block
Transducer Type
XD Error

Primary Value Type
Cal Point Hi

Cal Point Lo

Cal Min Span

Cal Unit

Sensor Type
Sensor SN

Sensor Cal Method
Sensor Cal Loc
Sensor Cal Date
Sensor Cal Who
Secondary Value Unit
Tertiary Value Unit
Trim PV Zero

Trim Mode

Ext Zero Enable
Model

Display Mode
Display Cycle

Test 1

Test3

Test4

TestS

Test6

Test7

Test8

Taa+ Q

Value Units

Standard Pressure
No error
differential pressure

0

0.71117

psi

Silicon resonant

factory trim standard calibraticn
01/01/1984 00:00:00.000

kPa

e

0

Trim disable
Enable

EJA

Engineering Unit
1

0

0

19

43

0
-Empty-

EaASA2nnnennnnnnnn

5.10 License File Transfers

The license file can be transferred easily to other computers. The process is a “Check-In/Check-Out” process.
When a license is on the computer, it is considered “Checked-Out”. When the license is on the license server, it is
considered “Checked-In”. When the license is “Checked-in”, it can be “Checked-Out” by other users. This enables
the license to be shared by many users.

5.10.1 Check-In
To Check-In the license from the current computer to the License Server, perform the following steps:

Step  Action

1 Verify your PC is connected to the Internet.

2 Select “Check-In” from the “License” Menu.

If the current computer is not licensed, an error message will
appear. If licensed, the program will contact the License Server
via the internet. It will check-in the license using the License ID
and Password used in Activation. The current computer will
then become un-activated.
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5.11 Options Menu

6.12.4.2 Language

Certain DD’s can be used in different languages. English is the default setting but some support other
languages. Note that main program frame will always be English. Only the DD based items — menus,
variables, etc. will change language. And will only change if the DD supports that language. In order to
change the Language setting, perform the following steps:

Step  Action

1 Ensure that the application is running.

popspopoope

2 Select Options = Basic from the main window. The Options Dialog
Box is displayed
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Step  Action

Options x

DD Language: |English ﬂ

mobilink Settings

Save | Cancel |

3 Click the “DD Language” drop down to select a different language.

DD Language: |English

French
German
Italian
Japanese (ja)

4 Select a language to translate the DD into. Click Save to save the
changed settings.

5 Restart DevComFF.Win for the changes to take place. If the language
is supported the DD will be translated. If not, the DD with default to
English.

5.12 Trending
5.12.1 Define Trend

The Trending menu is used to track dynamic device parameters over a specified period of time. Once a
parameter is tracked, it can be graphed and compared against other parameters tracked on the same time
period. Before a parameter can be graphed, a trend must first be created. To create a trend, perform the

following steps:

Step  Action
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Step

Action

1

Ensure that the application is running and is connected to a device.

ducer Block] - o x
View Blocks Trending DDLibrary Cloud License Window Help

Value [ Units

Tag: FTi05 1 DD: \594543\0008\0105.ffo © FF Actity © Trend Activity

Select Trending = Define Trend from the main window. The
Define Trend Dialog Box is displayed:

v

Define Trend

Select paamete(s), Masirm dsplayed 4, use CTRL key to select
™ Selct Al

Tine Starrp

Enteinenst [T [oecords %]
Forhowlong? [ [Fecondi 7 Contnous

Enter Fiename: (saved as a bt file)
ENDes 30008 FF T i 1105 Z0ETGHGE_TE0B08

I™ Creale C5V Fle ™ Contirue Trend on DevCanF Restat

01/01/1984 00:00:00.000

Tag: FT106 - Device: LC1 - Device ID: 5 o FEAdvy [ O TrendAdivty NUM

Select the information for the log file:

Select Parameters — Select up to four parameters to display at a
time. More than four can be recorded. Press the CNTRL key to
select multiple parameters.

Select All — All parameters are recorded, but only four are displayed.
Enter Interval - Input a number and select an interval from the drop
down box, i.e. Seconds, Minutes, Hours, and Days.

For How Long? — Input duration for how long to log the
parameter(s). This part will be grayed out if the “Continuous” check
box is selected. Unselect it for a finite duration.

Filename — The default directory is based on Windows User
Accounts however a log file can be saved anywhere.

Create CSV File — When selected a .csv file is also created for use in

MAN-1053 06/09/2021

Page 36



\; PROCOMSOL

Process Communications Solutions DeVC OmFF . Wln User Manual

Step  Action

3" party software.

Continue Trend on DevComFF.Win Restart — When selected, the
define trend is automatically restarted whenever DevComFF.Win is
launched.

Notes — The section can only be 250 characters long.

4 Click the “Start” button to start the Trend.

5 The Trend will then be started. At the lower right hand corner of
DevComFF.Win the “Trend Activity” light will come on. This
indicates that a Trend is in process. You cannot start another Trend
until this one is finished or the user stops the trend manually.

@ FF Activity @ Trend Activity

5.12.2 View Current Trend

When a trend is created DevComFF.Win creates a window that shows the graph of the current trend. To view
this trend, perform the following steps:

Step  Action

1 Ensure that the application is running and is connected to a device.

Tag: FTi05 1 DD: \594543\0008\0105 ffo © FF Acti iy © Trend Act ity

2 Ensure that a trend is in progress. The “Trend Activity” light at the
bottom of the screen is on if a trend is in progress. If not then the
light will be off.

@ FF Activity @ Trend Activity
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Step  Action

3 Select Trending = View Current Trend from the main window.

4 The DevComFF.Win Trend dialog opens up.

W3 Device Options View Blocks Trending DD Library Cloud _License
0238 B

0] [+o @la] L] o] =als|

- (2021/03/03)

L —
—

—
—

The user can manipulate the graph as desired. “Tracking” is the
term used to describe how the graph control follows the data,
changing the axis in real time so that all of the data is shown.
Below are the specific parts of the graph:

Tool Bar: There are multiple things that the user can do with the
graph.

P& Q& e B H &R

Resume All Tracking: The “Resume All” button - * - is grayed
out while tracking. If either axis is changed or the “Pause” button

is pressed, this will be come green - B - Pressing “Resume All
Tracking” will resume the tracking on the graph.

Pause All Tracking: The “Pause” button - I - pauses the graph in

its current state. Data is still added, however the current X-axis and
Y-axis spans no longer change. Pressing the “Resume” button will

continue tracking.

Scroll Axis: This is the default way to scroll both the X and Y-axis.

The “Scroll Axis” button - i - allows the user to scroll in both
directions on the graph.

Zoom Axis: The “Zoom Axis” button - ‘R - allows the user to
shrink or enlarge the scale of either axis. By moving up or down,
left or right, the span of each axis is changed.

Zoom Out All Axis: The “Zoom Out All Axis” button - & -
zooms out both the X-axis and Y-axis at the same time giving the
user a broader look at the graph.
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Step

Action

Zoom In All Axis: The “Zoom In All Axis” button - & - zooms in
both the X-axis and Y-axis at the same time giving the user view
over a smaller time period.

allowing the user to select a specific area of the graph to zoom in
on for a more detailed look.

Cursor: The “Cursor” button - ** - adds a cursor to the screen that

gives the coordinates of the graph at a certain time. Clicking and
moving the cursor can give the coordinates of any point on the
graph. See below for an example of using the “Cursor” tool:

Properties: The “Properties” button - - brings up the
“Properties” dialog box which gives the user the ability to
customize the graph as desired. Below is an example of one of the

I3 ST .
Properties” tabs:
Plot ==
Control || Layout | Chsnnets | Cursors | Limite | Labisls | X-axes | v-4ves | Lagend | Tabies | ToociBar | Data View |
Genersl | Tide | Background | Punt | Hints | File 140 | Annotstion Dretaulis |
Baorder Ster Outar Margin
Copy To ClipBoard Format |Mets File - N ,—#
[ = J bl 7 =i
File Column Separatos | Tab - | - | re ] A8 et
P = ™ Rased 5 :II B Ill

* Loweted ? |
W Cip Anrctahons Toluss =

Update Frame Rate Eﬁ_ j ¥ Autg Frame Rate

s

Copy To Clipboard: The “Copy To Clipboard” button - 5= - copies
the graph to the clipboard to allow the graph to be pasted into
documents like a report.

Save: The “Save” button - B - saves the graph as a “*.bmp”.
Print: The “Print” button - & - prints the graph.
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Step  Action

Preview: The “Preview” button - L& - gives a print preview of the
graph.
Title: The title gives the name of the parameter being trended, the
units that the parameter is being measured in, and the date(s) of the
graph.

(Parameter) (Units) - (Date)

Axis: The Y-axis is the units of the parameter. The X-axis is the
time in HH:MM:SS format.

Redraw: This section is disabled for View Current Trend.

5.12.3 View Past Trends

DevComFF.Win keeps a list of trends that have been done in the past. These trends are saved so that they can
be viewed at a later date. To select a trend to be viewed perform the following steps:

Step  Action

1 Ensure that the application is running, you do not have to be
connected to a device to use View Past Trends.

2 Select Trending = View Past Trends from the main window.

3 The Select Trend To Graph dialog will open.
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Step  Action
Select Trend to Graph - O X
M Tag Device Date Start Time
o1 FT106-1 5345430008001 6034 2021-03-11 091032
0z FT106-1 5945430008001 6034 2021-0315 131718
03 R-0301-TEMP2 0011510644-EPM-TEMP-0x226BBE10 2021-0318 141525
Device Tag: Browse
P Logged:
Device: | Parameter 1
F: ter 2
File Mame: | Pararneter 3
Parameter 4
Date: |
Start Time: |
Mates: ‘
Graph | Text | Delete | Cloze |
This dialog box is very similar to the “Download/View” dialog
box.
Graph: Opens the trend as a graph
Text: Opens the trend as a text file.
Delete: Deletes the trend from the database.
Close: Closes the dialog box.
4 The DevComFF.Win Trend dialog opens up when “Graph” is

selected.

w

B¥3|@ @R

B E &

- (2021103/03)

L[+ o ala) L] 5]

aph 1

— r

Teg:F ] © FrActivit @ Trend Actvity NUM

The user can manipulate the graph as desired. “Tracking” is the
term used to describe how the graph control follows the data,

MAN-1053 06/09/2021

Page 41



\; PROCOMSOL

Process Communications Solutions

DevComFF.Win User Manual

Step

Action

changing the axis in real time so that all of the data is shown.
Below are the specific parts of the graph:

Tool Bar: There are multiple things that the user can do with the
graph.

Yl [+ @ Q& [l i RESR

Resume All Tracking: The “Resume All” button - * - is grayed
out while tracking. If either axis is changed or the “Pause” button

is pressed, this will be come green - B - Pressing “Resume All
Tracking” will resume the tracking on the graph.

Pause All Tracking: The “Pause” button - I - pauses the graph in
its current state. Data is still added, however the current X-axis
and Y-axis spans no longer change. Pressing the “Resume” button
will continue tracking.

Scroll Axis: This is the default way to scroll both the X and Y-

axis. The “Scroll Axis” button - i - allows the user to scroll in
both directions on the graph.

Zoom Axis: The “Zoom Axis” button - ‘R - allows the user to
shrink or enlarge the scale of either axis. By moving up or down,
left or right, the span of each axis is changed.

Zoom Out All Axis: The “Zoom Out All Axis” button - & -
zooms out both the X-axis and Y-axis at the same time giving the
user a broader look at the graph.

Zoom In All Axis: The “Zoom In All Axis” button - & - zooms
in both the X-axis and Y-axis at the same time giving the user
view over a smaller time period.

allowing the user to select a specific area of the graph to zoom in
on for a more detailed look.

Cursor: The “Cursor” button - ** - adds a cursor to the screen that

gives the coordinates of the graph at a certain time. Clicking and
moving the cursor can give the coordinates of any point on the
graph. See below for an example of using the “Cursor” tool:
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Step  Action

Properties: The “Properties” button - - brings up the
“Properties” dialog box which gives the user the ability to
customize the graph as desired. Below is an example of one of the
“Properties” tabs:

[ Piot &

Control || Layout | Channets | Cursors | Limite | Labels | X4 | v-Awes | Legend | Tabies | ToolBer | Dataview |

General |T|:|Q | Background | Frird | Hirts i F4|p|,.l0i Annotation Dotauls |

Border Style Outar Margin
Copy To ClipBoard Fomat |Meta File | C Noe |5— |
-
File Column Separator | Tab - e R —_— =
= 7 Ramsed IS =1 |5 e
I =l
% Lowescad ? 5ol

¥ Cip Annotatons To Axex

Updats Frame Rate Eﬁ_ ill W AugoFrome Rate

s

Copy To Clipboard: The “Copy To Clipboard” button - 5= -
copies the graph to the clipboard to allow the graph to be pasted
into documents like a report.

Save: The “Save” button - M - saves the graph as a “*.bmp”.
Print: The “Print” button - & - prints the graph.
Preview: The “Preview” button - L& - gives a print preview of the
graph.
Title: The title gives the name of the parameter being trended, the
units that the parameter is being measured in, and the date(s) of
the graph.

(Parameter) (Units) - (Date)

Axis: The Y-axis is the units of the parameter. The X-axis is the
time in HH:MM:SS format.
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Redraw: Up to four parameters can be trended at the same time.
By clicking the check box for a parameter u can show one or four
at the same time for easy comparison over a period of time.

¥ Pressure inH20 [ Graph 3
[T Graph 2 [ Graph 4

Click “Redraw” and the parameters checked will be shown.

5.12.4 Stop Current Trend

Step  Action

1 Ensure that the application is running and is connected to a device.
T o [

2 Ensure that a trend is in progress. The “Trend Activity” light at the
bottom of the screen is on if a trend is in progress. If not then the
light will be off.

@ FF Activity @ Trend Activity
3 Select Trending - Stop Current Trend from the main window.
4 You will be asked if you want to stop the current trend. Click

“Yes”. This will stop the current trend.
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Step  Action

DeviComFF

':0] Do you want to stop the current Trend in progress?

5 The “Trend Activity” light will now be off.

£ FF Activity 3 Trend Activity

5.13 DD Functions
5.13.1 Adding a DD

DevComFF.Win allows the user to add a DD to the library when necessary. Each DD must be in its
appropriate destination for DevComFF.Win to find the DD. The format is:
“C:\ProComSol\FF\Library\xxxxxx\yyyy\” where “xxxxxx’’ represents the manufacturer ID and “yyyy”
represents the device type ID. The user does not need to add the directory structure, DevComFF.Win does that
automatically. To add a DD perform the following steps:

Step  Action

1 Ensure that the application is running, you do not have to be
connected to a device to use Add DD.

2 Select DD Library - Add DD from the main window.
3 The Add DD dialog will open.
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Add DD X

Select fio DD File: |C:\ack\01 01 ffa Bronze
Select .cff DD File: |C:\ack\D1D1D1.cff Browse |

Far FF. & ffo file and & .cff file are required.

DD Information
tanufacturer Mo: - 007151

Device Ma: 0644

Device Rew: 0

LERS o addDD | Close |
4 Click “Browse” and go to the location of the DD that is to be added.
5 The “DD Information” section will be populated. Confirm that it is

the correct DD. Below is an example of 0000¢2/0021/0201.fm6:

DO [nformation
b anufacturer Mo 0077151

Device Mo 0544
Device Rew: m
DD Rew: m

6 If the DD Information data is correct, click Add DD to add the files
to the DD Library.

5.13.2 DD Library Updates

The DD Library is updated generally every quarter. Users are notified by email when this occurs. You can
also check for updates by clicking DD Library—> Check for Updates. DevComFF.Win will then contact the
ProComSol DD Library Server and determine if a new DD Library is available. Note that you must have a
valid Update Subscription.

To check for DD Library updates perform the following steps:

Step  Action

1 Ensure that the application is running, you do not have to be
connected to a device to use Check for Updates. However you do
need internet access.
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0 Browses - [UA Transducer Block]
View Blocks Trending DD Library Cloud License Window Help

Value

Units

FF Activity

© Trend Actvity

“oD:

[Tog:FT

2 Select DD Library = Check for Updates from the main window.

3 The DD Library Update dialog box will open. What is displayed
is based on the Current DD Library Version, Available DD Library
Version, and status of the Update Subscription for this license.

DD Library Update

28

Current Version: 201704

DD Library Up to Date

DD Library is current, no update required.
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Step  Action

DD Library Update [

Current Version: 201703

DD Library Update Subscription Expired

Update Subscription expired for this license. Contact ProComSol to
renew your subscription.

4 DD Library Update ()

Current Versian: 201703

DD Library Update Available

201704 Install

DD Library Update is available. Press “Install” to download the
new library.

5 While the DD Library download and installation is occurring, a bar
shows progress:
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Step  Action

DD Library Update [

Downloading DD Library...

|

6 The user is notified when the download and installation is complete:

Install

I . DD Library Update complete

_ o |

5.14 Program Updates

The DevComFF.Win program is updated periodically to add new features or to fix reported issues. Users are
notified by email when this occurs. You can also check for updates by clicking Help > About DevComFF
- Check for Updates. DevComFF.Win will then contact the ProComSol Update Server and determine if a
new program update is available. Note that you must have a valid Update Subscription.

To check for program updates perform the following steps:
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Step

Action

1

Ensure that the application is running, you do not have to be
connected to a device to use Check for Updates. However you do
need internet access.

Value [ Units

Tag: FTi05 1 DD: \594543\0008\0105 ffo © FF Actity © Trend Activity

Select Help—> About DevCom FF - Check for Updates from the
main window.

The Update dialog box will open. What is displayed is based on the
Current Program Version, Available Program Version, and status of
the Update Subscription for this license.

Updates >

Current Version: 0.1

DevComFF Up to Date

Program is current, no update required.
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TR TR I Y o'e =3 LT =" o1 P 8 W O L LI L L L L )

Updates x

Current Version: 0.1

o e Ly

Update Subscription Expired

Update Subscription expired for this license. Contact ProComSol to
renew your subscription.

LS O b LS LT L] LCIELE LU L L Ly g

4 Updates >

Current Version: (i 5

o s

DevComFF Update Available

1.0 Install

Program Update is available. Press “Install” to download the new
library.

5 While the Program download and installation is occurring, a bar
shows progress:
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Updates >

Downloading DevComFF Update. ..

B

6 The user is notified when the download and installation is complete:
¢
!
I DevComFF P

I i~ DevComFF Update file Unzip complete

5.15 Cloud Functions
5.15.1 Enabling Cloud Functions
Cloud functions are not yet available. Stay tuned!
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Appendix A

Troubleshooting Guide

Problem:
No FF devices in Live List

Hardware Check:

Verify the following:
FF device is connected to power conditioner and is powered.
mobiLink is connected to power conditioner and is powered.

Problem:
Activation by Internet blocked by Firewall

Try the following:

1. Allow one time access to internet via your computer’s Firewall settings.

2. Disable Firewall.
3. Use manual activation method.

Problem:
Active Windows not shown in Windows drop down list

Try the following:
1. Select Window—=> Cascade or Window=> Tile.
2. All Windows will now be shown
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Appendix B

Contact Information

ProComSol, Ltd

Process Communications Solutions
13001 Athens Ave

Suite 220

Lakewood, OH 44107

USA

Phone: 216.221.1550

Email: sales@procomsol.com
support@procomsol.com

Web: www.procomsol.com
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